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Getting Started

What is PKDirUse for Windows?
PKDirUse for Windows shows the disk space used by directories and their subdirectories. You can 
create and save lists of directories whose tree sizes you want to find out. The results appear as a tree 
and can also be saved. For example, if you select directory C:\WINDOWS, the result will show the size 
of the C:\WINDOWS directory plus all the files in its subdirectories. You can then also view the size of 
directory trees within the C:\WINDOWS directory.
There are many ways to use PKDirUse. For example, you can use it to find out:

which directory tree is using most space;
how much disk space is being used in users' home directories;
if two or more directory trees are identical (by comparing their sizes); you can also browse down 

the directories to see where they differ.
Using PKDirUse for Windows is very easy. If you require more information while you're using it, press 
F1. This will provide context-sensitive help. 

See also
How the result appears
Licensing and ordering
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Licence Agreement and Copyright
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Licence Agreement and Copyright

Licence Agreement
You should carefully read the following terms and conditions before using this software. Your use of 
PKDirUse indicates your acceptance of this Licence Agreement.
For information on distributing the shareware evaluation version of PKDirUse, see the section titled 
Shareware Information.

Evaluation Version
This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you use this software after the 21-day evaluation period, a registration fee is required. 
For information on how to register PKDirUse, see the section titled Ordering Information.

Registered Version
The registration fee will license one copy of PKDirUse for Windows (16-bit) version 3 for use on any one
computer at any one time. You must treat this software just like a book. For example, this software may 
be used by any number of people and may be moved from one computer location to another, so long as 
there is no possibility of it being used at one location while it is being used at another (just as a book 
cannot be read by two people at the same time).
You may access the registered version of PKDirUse through a network if you have obtained individual 
licences for the software covering all workstations that will access the software through the network. For 
example, if three workstations will access PKDirUse on the network, each workstation must have its own
PKDirUse licence, regardless of whether the workstations are used to access PKDirUse at different 
times or concurrently.

Governing Law
This agreement shall be governed by the laws of the United Kingdom.

Disclaimer of Warranty
PKDIRUSE IS SUPPLIED "AS IS". THE AUTHOR DISCLAIMS ALL WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING, WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY AND OF 
FITNESS FOR ANY PURPOSE. THE AUTHOR ASSUMES NO LIABILITY FOR DAMAGES, DIRECT 
OR CONSEQUENTIAL, THAT MAY RESULT FROM THE USE OF PKDIRUSE. 
THE USER MUST ASSUME THE ENTIRE RISK OF USING PKDIRUSE.

Copyright
PKDirUse for Windows, copyright © 1994-1997 Praful Kapadia. All rights reserved.



Ordering Information

Why register?
This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you use this software after the 21-day evaluation period, a registration fee is required. 
Unregistered use of PKDirUse after the 21-day evaluation period is in violation of UK and international 
copyright laws.
By registering, you will:

receive a registration number (via e-mail if you provide an e-mail address);
receive free technical support via e-mail for 3 months;
see your name and registration number displayed in the About box;
be entitled to a free upgrade from the 16-bit version to the multithreaded 32-bit version of 

PKDirUse (which is currently being tested);

How to register
You can pay using one of the following methods:

by cheque (check) using the order form; or
by using the shareware registration service on CompuServe.

Site licence arrangements may be made by contacting the publisher. 
All orders are subject to the PKDirUse Licence Agreement.

See also
How to let PKDirUse know you've registered



Order Form
A payment of £15 (15GBP) must be made in GB pounds drawn on a GB bank. You can also send 
international postal money orders in GB pounds.
Cheques or money orders should be made payable to:

"P Kapadia"
Payment should be sent to:

P Kapadia
75 Salisbury Walk
London N19 5DU
United Kingdom 

To print the form, choose the Print Topic command on the File menu. 
___________________________________________________________________________

Name: _______________________________  Date: ___________________

Company: _______________________________________________________

Address: _______________________________________________________

         _______________________________________________________

City, State: ___________________________________________________

Zip/Postcode: __________________________________________________

Country: _______________________________________________________

Day Phone: ________________________  Eve: ______________________

Electronic Mail address: _______________________________________

How did you hear about PKDirUse?

Comments:



Registering using CompuServe
You can register PKDirUse by using the shareware registration service on CompuServe. A registration 
fee of $25 (25USD) will be automatically added to your CompuServe bill. 
To register, use the CompuServe command GO SWREG, select "Register Shareware" and follow the 
menus. The registration number for PKDirUse is 13922. The rest of this section provides detailed 
instructions for registering PKDirUse.
Registering using WinCIM:
1. From the Services menu, choose the Go command and type SWREG.
2. In the Shareware Registration box, double click on the "Register Shareware" line. The Registration 

Agreement dialogue box appears.
3. After you have read the Registration Agreement, click on Proceed. The Geographic Region dialogue

box appears.
4. Select your region.
5. In the Register Shareware box, double click on Registration ID and enter 13922 as the ID number:
6. Double click on "Display Selected Titles".
7. Click the Register button to fill in your order information. 



Shareware Information
The full licence agreement is provided in the section titled Licence Agreement and Copyright. Please 
read it before using this software.

Evaluation and Registration
This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you use this software after the 21-day evaluation period, a registration fee is required. 
Please see the section titled Ordering Information to find out how you can register PKDirUse.

Distribution
Provided that you distribute only the shareware version (that is, you do not pass on any registration 
details), you are licensed to:

make as many copies of the shareware version of this software and documentation as you wish;
give exact copies of the original shareware version to anyone;
distribute the shareware version of the software and documentation in its unmodified form via 

electronic means. 
There is no charge for the above.
You are prohibited from:

charging, or requesting donations, for any such copies, however made; 
distributing the software and/or documentation with other products (commercial or otherwise) 

without prior written permission.



Information about PKDirUse for Windows (32-bit)
The 32-bit version of PKDirUse is currently being tested. This, first, 32-bit version of PKDirUse will not 
be substantially different from the 16-bit version. The intended features for the 32-bit version are:

full 32-bit application;
Windows 95 look and feel;
support for multithreading (so that multiple calculations can run simultaneously);

If you have registered the 16-bit version of PKDirUse, and would like to participate in the beta 
programme for the 32-bit version, please contact the publisher. Because there are already a number of 
beta testers, you may not be selected for this beta programme. If this is so, you will be considered for 
the next beta programme.

Important      The precise functionality of the 32-bit version has not been finalised. Therefore, the 
features of the 32-bit version mentioned in this Help file are provided only as a guide and should not be 
regarded as a commitment from the publisher. 



Register PKDirUse
Once you receive a registration number, you can let PKDirUse know you have registered:
1. From the Help menu, choose the About command.
2. Press the Register button.
3. Enter your name and registration number exactly as they appear on the registration instructions 

sent to you when you registered PKDirUse. You cannot substitute a different spelling for your name 
or use a different name. If you register correctly, your name will appear in the About dialogue box, 
and the registration reminder dialogue box will no longer be displayed when you start PKDirUse. 

You should save the registration instructions for possible use with future upgrades, or in case you re-
install PKDirUse.

Note      If your name is spelt incorrectly in the registration instructions, please contact the publisher to 
receive a new registration number.



Menu Commands
Choose one of the following to get help on its sub-menus:
File menu commands
Directories menu commands
Tools menu commands
Windows menu commands
Help menu commands

You can get help on any menu command while you are using PKDirUse. To get help, highlight the menu 
command and press F1.
Many menu commands can be accessed more quickly by keyboard shortcuts.



File Menu Commands
The following commands are available on the File menu:
New
Open
Save Directory Selection
Save Directory Selection As
Save Result
Save Result As
Stop
Close
Exit

Note      The menu commands that appear on the File menu vary according to the window that is 
highlighted. For example, the Close command appears only when you select a result window.



New Command (File Menu)
The New command clears all directory selection details so that you can create a new list.



Open Command (File Menu)
The Open command opens a file that contains directory selection information. Use the Save Selection 
command to save directory selection information.
You can also open a file by dragging it from File Manager (or Explorer) onto PKDirUse.



Save Directory Selection Command (File Menu)
The Save Directory Selection command saves directory selection information in a text file.



Save Directory Selection As Command (File Menu)
The Save Directory Selection As command saves the directory selection in a text file. You are asked for 
a new file name.



Save Result Command (File Menu)
The Save Result command saves the contents of a result window in a text file.



Save Result As Command (File Menu)
The Save Result As command saves the contents of a result window in a text file. You are asked for a 
new file name.



Stop (File Menu)
The Stop command terminates the calculation that is occurring in the highlighted result window.

Note      This command is available only in the 32-bit version of PKDirUse.



Close Command (File Menu)
The Close command closes a result window.



Exit Command (File Menu)
The Exit command closes PKDirUse.



Directory Menu Commands
The following commands are available on the Edit menu:
Calculate Sizes
Add to Selection
Remove from Selection



Calculate Sizes Command (Directory Menu)
The Calculate Sizes command starts the calculation process. This involves working out the sizes of your
selected directories (and their subdirectories).
The output appears in the result window.



Add to Selection Command (Directory Menu)
The Add Selection command copies a directory name from the Available Directories list to the Selected 
Directories list.
You can also add a directory name to the Selected Directories list by dragging it from the Available 
Directories list, or from File Manager (or Explorer). If you use File Manager or Explorer, you can drag 
more than one directory onto PKDirUse.

See also
Remove from Selection



Remove from Selection Command (Directory Menu)
The Remove from Selection command removes a directory name from the Selected Directories list.

See also
Add to Selection



Tools Menu Commands
The following commands are available on the Tools menu:
Options
Map Network     Drive  
Disconnect Network Drive



Options Command (Tools Menu)
The Options command displays the Options dialogue box which lets you change options for PKDirUse.



Map Network Drive Command (Tools Menu)
The Map Network Drive command maps a letter to a network drive.
This command is available only if a network is detected.

See also
Disconnect Network Drive



Disconnect Network Drive Command (Tools Menu)
The Disconnect Network Drive command removes a mapping between a letter and a network drive.
This command is available only if a network is detected.

See also
Map Network     Drive  



Window Menu Commands
The following commands are available on the Window menu:
Tile
Cascade
Arrange Icons
Refresh



Tile Command (Window Menu)
The Tile command arranges all windows so that they do not overlap on the screen. Use this view to see 
windows that may be hidden or to organise the windows on the screen.



Cascade Command (Window Menu)
The Cascade command arranges all windows so that they overlap on the screen. Use this view to see 
windows that may be hidden or to organise the windows on the screen.



Arrange Icons Command (Window Menu)
The Arrange Icons command arranges all iconised windows on the screen.



Refresh Command (Window Menu)
The Refresh command updates the screen display. You can use this command to update the list of drive
letters if you, for example, map new drives from File Manager or Explorer. If you map drive letters from 
PKDirUse, the Refresh command is automatically carried out.



Help Menu Commands
The following commands are available on the Help menu:
Contents
Commands
Procedures
Keyboard
Search for Help On...
How to Use Help
Ordering Information
Licence Agreement
About



Contents Command (Help Menu)
The Contents command displays this Help file.



Commands Command (Help Menu)
The Commands command displays help for menu commands.



Procedures Command (Help Menu)
The Procedures command displays procedures to accomplish commonly performed tasks in PKDirUse.



Keyboard Command (Help Menu)
The Keyboard command displays the list of keyboard shortcut keys available in PKDirUse.



Search for Help On... (Help Menu)
The Search for Help On... command searches this Help file for a keyword.



How to Use Help (Help Menu)
The How to Use Help command displays information on how to use the Windows Help system.



Ordering Information (Help Menu)
The Ordering Information command displays instructions for ordering PKDirUse.



Licence Agreement (Help Menu)
The Licence Agreement command displays licensing, warranty, and copyright information for PKDirUse.



About Command (Help Menu)
The About command displays program information about PKDirUse.



Directory Level to Display
Setting the directory level affects how far down a directory tree you can see in the result window and 
what information is saved when you save the contents of the result window. The sizes displayed in the 
result window are unaffected. For example, if a directory structure consists of:
C:\APPS

\WORD
TEMPLATE

\EXCEL

and you specify a level of 2, you will be able to view the directory sizes for APPS, WORD and EXCEL 
but not TEMPLATE. 
This option is useful if you have a server whose structure is something like:
\USERS

\FRED
\JANE
\MARIE

By specifying a level of 2, you can find out how much disk space is used by each person. No information
about the users' subdirectories will be provided and, when you save the results, information about the 
users' subdirectories will not be saved.



Keyboard Shortcuts
If you prefer to keep your hands on the keyboard when you are working, you can use the shortcut keys. 
For example, pressing CTRL+C lets you calculate the sizes of selected directories; it is the same as 
choosing Calculate Sizes from the Directory menu.
The following table provides available shortcut keys.

To Press
New (directory selection) CTRL+N
Open (directory selection) CTRL+O
Save (directory selection) CTRL+S
Stop calculation (32-bit version) CTRL+Z
Exit CTRL+X
Calculate sizes CTRL+L
Add to directory selection CTRL+A or

INSERT
Remove from directory selection CTRL+R or

DELETE
Options CTRL+T
Refresh display F5

Note      The '+' means you should press and hold down the keys mentioned at the same time. For 
example, CTRL+S means you should press and hold down the CTRL key, and then press the S key 
(without releasing the CTRL key); you should then release both keys at the same time.



Main Window
The main window of PKDirUse contains the following elements:
Path
Filter
Directories to choose from
Drives available
Files in directory
Add button
Selected Directories
Description
Clear List button
Remove button



Path (Main Window)
The Path box lets you manually change the current drive letter and directory for which details are 
displayed.
The Path box accepts UNC (Universal Naming Convention) paths. The format of UNC paths is \\
SERVER\SHARENAME. You cannot see directories or files of UNC paths but you can add them to 
Selected Directories list.



Filter (Main Window)
The filter box determines which files are used to calculate the sizes of directories. For example, if you 
want to know how much disk space is being used by files with extension TMP, select the *.TMP filter.
The list of filters cannot be amended.



Directories to Choose From (Main Window)
The directory box displays directories for the drive currently selected. 
You can add files to the Selected Directories list by:

pressing the Add button; or
dragging a directory to the list; or
pressing the Insert key. 



Drives Available (Main Window)
The drive box displays drives currently available. Press F5 to update the list.



Files in Directory (Main Window)
The file box displays files in the directory currently selected.
You can double-click on a filename to open the file.



Add button (Main Window)
The Add button copies a directory name from the directory list to the Selected Directories list.

See also
Directories to choose from



Selected Directories (Main Window)
The Selected Directories list displays paths for which directory sizes are calculated.



Description (Main Window)
The Description box lets you provide a name for the list you create. This description is saved when you 
save the Selected Directories list. For example, if the directory selection contains users' home 
directories on server ACCOUNTS, you can type 'Users on ACCOUNTS server'.



Clear List button (Main Window)
The Clear List button removes all entries in the Selected Directories list.



Remove button (Main Window)
The Remove button removes the currently highlighted entry in the Selected Directories list.



Options Dialogue Box
The Options dialogue box is displayed when you choose the Options command from the Tools menu. 
You can change the following options:
Results options
Display options
Advanced options (32-bit)



Options: Results
The Results options are part of the Options dialogue box. The Results options affect the display of the 
result window. 

Note      The Results options take effect for new directory calculations only. Any completed or active 
calculations use the Results options that were set when the directory calculations started.

You can change the following Results options:

Unit
Determines what unit is used to display the results. Directory sizes in the result window can be 
expressed in bytes, kilobytes (K) or megabytes (MB).
One kilobyte is 1,024 bytes and one megabyte is 1,048,576 bytes

Formatting
The following options determine how the directory sizes are formatted.

Show thousand separator
Displays a separator between groups of digits in large numbers, for example: 1,000,000.

Append unit name
Displays the unit used for the directory size. The unit is bytes, K (for kilobytes), or MB (for megabytes).

Highlight
The following option highlights certain directories.

Directory trees exceeding ...
Highlights a directory if its size and the size of its subdirectories exceed the value specified. The unit 
used to express the value is the same as the unit specified in the Unit box.

Directory levels to display
The following option determines the structure of the result window.

Maximum directory levels to display
Displays all or some directory levels. This affects how far down a directory tree you can see and what 
information is saved when you save the contents of the result window. The sizes displayed in the result 
window are unaffected. For example, if a directory structure consists of:
C:\APPS

\WORD
TEMPLATE

\EXCEL

and you specify a level of 2, you will be able to view the directory sizes for APPS, WORD and EXCEL 
but not TEMPLATE. 
This option is useful if you have a server whose structure is something like:



\USERS
\FRED
\JANE
\MARIE

By specifying a level of 2, you can find out how much disk space is used by each person. No information
about the users' subdirectories will be provided and, when you save the results, information about the 
users' subdirectories will not be saved.



Options: Display
The Display options are part of the Options dialogue box. You can change the following Display options:

Tool tips
Tool tips are small windows that pop-up to provide immediate help about parts of the screen.

Toolbar
Displays tips when you position the mouse over a button on the toolbar.

Window position at startup
The following options determine where on the screen PKDirUse appears when you start it.

Centre of screen
Displays main window in the centre of the screen.

Last saved
Displays main window in the position it was when you last quit PKDirUse.

Number of recently used entries for
These options specify how many past entries are saved in the file and path lists.

Files
Specifies how many recently opened and saved files appear in the File menu.

Paths
Specifies how many paths you typed appear in the Path list.



Options: Advanced (32-bit)
The Advanced options are part of the Options dialogue box. Do not change these options unless you are
an experienced user of Windows and are familiar with the concepts mentioned below:

Calculation thread priority
The calculation thread priority determines which Windows thread priority a calculation is started with. 
Each calculation runs in its own thread. The main thread priority is always Normal. 
Changing the thread priority to the highest value is not necessarily the optimum setting. The optimum 
setting depends on a number of factors. The default setting usually provides good performance.

Thread Priority Meaning
Highest The thread's priority is two points above normal. 
High The thread's priority is one point above normal.
Normal The thread has normal priority.
Below normal The thread's priority is one point below normal.(recommended)
Low The thread's priority is two points below normal.
Lowest The thread executes only when the system is idle. Windows won't 

interrupt other threads to execute a thread with this priority.

Note      All updates to the result windows are performed by the main process thread (which always runs 
at Normal priority). This occurs because each calculation thread passes updates to the main thread. 
Therefore, setting the calculation thread priority equal to or greater than Normal will usually create a 
bottleneck and, consequently, reduce the responsiveness of PKDirUse. 
On computers with multiple processors, the multithreading behaviour will be different. 



Result Window
The picture below shows the results of calculating sizes for a directory called C:\WIN:

The picture shows that the number in brackets (after the name of a directory) always indicates the size 
of a directory and all its subdirectories.

Examples
1. If you want to find out how much space is used by all files on your C: drive, add the C: drive to the 

Selected Directories list.
2. If you want to find out the total space used by users in their home directories, add each user's home

directory to the Selected Directories list. Alternatively, if the home directories are the subdirectories 
of a particular directory, add the parent directory of the home directories to the Selected Directories 
list.



Excluded Directories
MS-DOS and Windows do not allow directory paths to exceed a certain number of characters. When 
PKDirUse finds long paths, it cannot process them because MS-DOS and Windows do not recognise 
them. Therefore, some of the sizes shown in the result window may be incorrect if long paths are found. 
You will be told if long paths are found.

Long paths may exist for many reasons, for example:
the directories were created using another operating system (such as Windows 95 or Windows 

NT);
a subdirectory is shared out and many subdirectories are added by the user connected to the 

share; consequently, the new path relative to the share may be valid but invalid relative to the 
subdirectory's absolute path on the server.

This limitation is encountered even if you run PKDirUse on a different operating system such as 
Windows NT. This limitation is overcome in the 32-bit version of PKDirUse.

See also
The directory sizes are not correct



Procedures
How to use PKDirUse



How to use PKDirUse
The following procedure describes how to use PKDirUse.
1. In the Available Directories box, locate the directory whose tree size you want to find out.
2. Choose the Add Button to add the directory to the Selected Directories list.
3. Repeat steps 1 and 2 for other directories whose tree sizes you require.
4. To start the calculation, press the Calculate Sizes button on the toolbar.
The result window will display the directory sizes.

See also
Results options
The directory sizes are not correct



Questions, Problems and Solutions
The directory sizes are not correct
Is PKDirUse connected with PKZip?
The settings for the 16-bit and 32-bit versions are not synchronised



The directory sizes are not correct
The sizes returned for directories may be wrong or appear to be wrong for several reasons. Here are 
some:

If you are comparing the sizes returned by PKDirUse with another program, it is possible that the 
other program does not include certain files and directories; for example, system and hidden files may be 
excluded. PKDirUse includes system and hidden files. Also, if you are running Windows 95 or Windows 
NT version 4, some programs may exclude system directories such as the RECYCLED directory. The DIR
command excludes the RECYCLED directory by default.

The sizes returned by PKDirUse may be incorrect if the directory path is being updated while 
PKDirUse is running.

The sizes returned by PKDirUse may be incorrect if it finds long paths. See the section titled 
Excluded Directories for more information.

The sizes returned by PKDirUse may be incorrect if you do not have "list" permission for the 
complete directory tree. This usually means your network administrator does not want you to see the 
contents of specific directories. The consequence is that the directories cannot be seen by PKDirUse.

Important      During testing, the results produced by PKDirUse were double checked and found to be 
accurate. If it is important to you that the results produced by PKDirUse are entirely correct, you are 
advised to double check them.



Is PKDirUse connected with PKZip?
No. PKZip is published by a different company and has no connection with PKDirUse. 'P' and 'K' are the 
author's initials.



The settings for the 16-bit and 32-bit versions are not synchronised
The preferences you specify in the Options dialogue box and the position of the two main Windows are 
saved in different places for the 16-bit and 32-bit version of PKDirUse. Therefore, any changes you 
make in the 16-bit version are not reflected in the 32-bit version (and vice-versa). However, when you 
upgrade from the 16-bit version to the 32-bit version, your preferences in the 16-bit version are 
transferred to the 32-bit version.
For the 16-bit version, your preferences are saved in the file PKDIRUSE.INI.
For the 32-bit version, your preferences are saved in the Windows Registry.

Warning      Do not modify PKDIRUSE.INI or the Windows Registry. Incorrect modifications may cause problems for 
PKDirUse or your computer.



Feedback
Before sending any comments, check this Help file, especially the section titled Questions, Problems 
and Solutions.
You can send suggestions, problems and questions using:
Electronic mail (Internet): Praful@CompuServe.com
Post: Praful Kapadia, 75 Salisbury Walk, London, United Kingdom, N19 5DU. 
If you are sending bug reports, please provide as much information as possible, such as:

operating system;
version numbers;
error message(s);
steps to reproduce error;
how you can be contacted, for example, your e-mail address.
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Technical Information
This section provides background information about PKDirUse. You do not need to know it to use 
PKDirUse.
Version history
Production information
Limitations



Version History
This section provides the history of PKDirUse.

Version 1.0 (1994)
This version was written in Microsoft Visual Basic. It provided directory sizes for a list of user-specified 
directories.

Version 2.0 (August 1995)
This version was functionally identical to version 1. The directory sizing routines were replaced by a DLL
written in Borland Delphi. This reduced the time taken to sum up sizes for large directory trees from 
minutes to seconds.

Version 3.0 (January 1997)
This was a complete re-write in Borland Delphi. The following features were added:

The results were displayed using the File Manager/Explorer tree metaphor. This meant only top 
level directories needed to be specified because other information could be obtained by drilling down to 
lower directories.

User-configurable units for results.
User-configurable formatting.
Maximum directories to display
Context-sensitive help.
Threads support: to provide multiple simultaneous calculations (32-bit).
Use of Windows 95 controls (32-bit).



Production Information
The following were used to produce PKDirUse:

Software development: Borland Delphi version 1.0 (16-bit) and Delphi version 2.0 (32-bit).
Help file: Microsoft Word 6.0 using a template based on the WHAT6 template (available from 

Microsoft).
Graphics: CorelDraw 3.0 for splash screen and Microsoft Paint for Help file graphics and program

bitmaps.



Limitations
The PKDirUse has the following known limitations:

The maximum size of a directory tree is 1.7 * 1038 bytes (10 to the power of 38).
The maximum length of a directory path is determined by DOS/Windows (see the section titled 

Excluded Directories for more information).
There is no (known) built-in limit to the number of threads that can be run simultaneously. Usually,

the computer's specification will determine the maximum number of threads that can be run (32-bit). 




